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Chapter 1

Introduction
This chapter provides an overview of the Map95 software features and capabilities.

C

ongratulations on the purchase of the Map95 graphical mapping software. Map95 is simple, easy to
use visual mapping software for the Loop Telecom O9500 SDH/SONET multi-services cross connect
platforms. By default, the O9500 uses a VT100/telnet user console for card configuration, system
configuration, mapping, etc. As more cards are added to the O9500 platform, cross connecting (mapping)
DS0s can become confusing and time consuming using the serial/telnet console. Map95 provides clarity
using graphical representation, speeds up cross connect mapping and documentation.

Productivity Software for O9500 Configuration
Map95 software is productivity software with graphical mapping. Map95 is a craft tool that fills the gap
between the serial/telnet console and complex network management and circuit provisioning systems.

Configure O9500 Cards
Map95 is used for the TSI (Time-Slot Interchange) Cross connect, commonly called “mapping”. Card
system configuration is performed using the serial/telnet console port. For example, SDH or SONET, card
registration, unit IP address, SNMP parameters, low speed card T1 framing and line build out, router card
configuration, voice card dB levels, etc. are all configured using the serial/telnet console port.

Map95 Export and Import Functions
Map95 software has a map export and import function. TSI (Time-Slot Interchange) cross connect maps
can be exported in a comma delimited (csv, or comma separated values) format for import into spreadsheets
or in text form for word processors. Create system documentation quickly and efficiently with the export
function. Spreadsheet files may be modified off line and imported back into the O9500, creating or
modifying the time-slot cross connect map. User added rows beginning with “#” are ignored on import.
Additional descriptive columns can be added after the 10 columns that contain the mapping data.

Windows XP, Vista, 2008R2, 7 and 8 Compatible
Map95 operates with Microsoft Windows XP, XP-Pro, Vista, 7 and 8, both 32 bit and 64 bit, as well as
Windows 2008R2 (which is 64 bit only).

Map95 Licensing
Map95 software is licensed per controller. Each O9500 requires one or two license keys, one per controller.
One license file (.lcf) is created per O9500.Once Map95 and a license is purchased, it can be distributed to
an unlimited number of PCs and used by an unlimited number of technicians on that O9500. Licenses are
available from DCB and can be granted almost immediately using email.
Map95 software accesses the local license (.lcf) file each time a connection is made to an O9500.
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Map95 and SNMP Version 1 or Version 3
Map95 uses SNMP commands to communicate with the O9500.Therefore, Map95 requires an Ethernet
connection to the O9500.The O9500 can have extensive mapping that can take time to read from an O9500
or import into an O9500. An Ethernet link with low propagation delay from the PC to the O9500 will
minimize the wait time for these operations. Map95 supports both SNMP Version 1 and SNMP Version 3.
(The O9500 does not support SNMP Version 2.) SNMP Version 3 uses authentication keys for secure
connections. For SNMPv3, context, user name and keys are required.

Demonstration Version
For demonstration purposes, Map95 is available with a 30 day demo license. Please contact either your
DCB sales representative, call DCB at 217-897-6600, or send email to: sales@dcbnet.com.

Map95 Applications
Map95 is an ideal tool for telecommunications technicians who work with the Loop O9500 products. The
learning curve for mapping the O9500 is dramatically reduced by using graphical mapping rather than the
serial/telnet mapping method. Accuracy is increased.
Once an O9500 is in service, changes are intermittent. Graphical representation of the mapping and the
simplicity of the visual process makes recall of the mapping process much faster.
Copies of the Map95 software can be distributed to an unlimited number of users. The software license is
per O9500 unit/controller. License files can be duplicated and used on any number of PCs.

Other Features
Visual Highlight and Click Mapping
To map a DS0 or multiple DS0s, DS0s to be mapped are highlighted and the “Map” button is clicked.
Un-mapping uses the “UnMap” button. Analog DS0s are visually differentiated from digital DS0s.
Huge Time Savings
Every cross connect mapping operation reduces a couple of dozen terminal key presses to a simple highlight
and click operation. Visual mapping can save hours of mapping for a loaded O9500 chassis.
Increases Accuracy
Links between feature cards are visually displayed. The visual display with varied colors is much easier to
understand than row and column presentation of mapping.
Auto-Selection of Voice or Data
The mapping software automatically selects voice or data when low speed feature cards are mapped. E&M
cards are unique. E&M cards can be set to voice or data, whether set to Transmit Only (TO) or Tie Line
Types I through V.
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Change SDH/SONET granularity with a mouse click within Map95
For unmapped SDH/SONET transport segments on the XCU controller cards and the SDH/SONET
tributary cards, the granularity can be changed with a right-click that brings up a box of radio buttons for
various granularity settings.
Change T3 Framing with a mouse click within Map95
For unmapped T3 ports, a right-click brings up a box of radio buttons with choices for unframed, C-Bit or
M-13 framing.
Change Ethernet High Speed Trib card mode and payload mode with a mouse click
Use a right mouse click with unmapped high speed Ethernet tributary cards to bring up a box with radio
buttons to change mode (e-line, e-lan, portmap) and payload mode (granularity).
Mutiple Ways of Viewing Mapping
Map95 provides simple or complex map views. As more and more cross connects are made, it becomes
important to provide a method of viewing the map in smaller segments to avoid confusion. Map95 also has
an SNCP (Sub-Network Connection Protection) view to show primary and protected paths.
Short Learning Curve
Visual mapping is more intuitive. More of the mapping options are on the single mapping screen.
Small Program Footprint
The mapping software is a small, efficient program. Users can open multiple program copies when
configuring multiple O9500s to better visualize the communications links.
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Chapter 2

Installing the Map95 Program
This chapter details the installation process.

Overview
Map95 comes as in installer file for Microsoft Windows XP, Vista, 7 and 8. To install the software, execute
the file with a name similar to “Map95_v1_02.exe”. Please follow the on screen procedures to complete the
installation. The following three questions will be asked during the installation process: acceptance of the
End User License Agreement (EULA), the installation location of Map95, and if the creation of a desktop
icon for Map95 is desired.

Installation
Run Map95_v1_02.exe File
Run the file “Map95_v1_02.exe”. The displayed screens are listed in sequence below. Follow the onscreen instructions: NOTE: If an older version of Map95 is already installed on your system, it is not
necessary to remove it before installing a newer version of Map95.
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The license agreement, shown on the following page, must be accepted to continue the software installation.
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Choose the location to install the program's shortcuts or select the default location.

Choose whether or not to create a desktop icon.

You can select a start menu folder for the shortcut location.

7

Map95 User’s Guide

You can chose to create a desktop icon.
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Click on “Install” to proceed with the program installation. The program typically installs in less than a
minute.
The program is now installed. If the box “Launch Map95” is checked, the program will be launched when
the “Finish” button is clicked.
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Start the Map95 Program
Click on the screen icon or run Map95 from the Program Manager.
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Chapter 3

Creating License Files
This chapter describes the process for creating license files. A license file is required for
each O9500 that is managed.

Overview
License files are created for each O9500 unit. An O9500 has one or two controllers. The controller serial
numbers are used by DCB to create a 16 digit license key. The serial number(s) and the 16 digit license key
are used to create the license key file (lcf). One .lcf file is created for each O9500.

Select License Key File Screen
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Edit Device Configuration
Basic information is entered in the Edit Device Configuration screen.

Edit Device Configuration Screen

Entering Device Configuration Information
1.

Enter the IP address of the O9500

2.

Select SNMPv1 or SNMPv3. The details entered must match the O9500. For example, for SNMPv1,
the Get Community and Set Community must match between the lcf file and the O9500.
Enter the controller serial number(s) and the Controller license key(s) provided to match that
Controller card serial number.
The “Edit Device Configuration” screen has an option to probe the O9500 for the Controller serial
numbers. The serial numbers can also be obtained from the serial/telnet screens of the O9500.

3.
4.
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Completed Device Configuration Screen
The sample Edit Device Configuration screen below has the controller serial number and license key
entered into the fields near the bottom of the screen.

Click on the Save button to complete the configuration.
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Chapter 4

Using Map95
This chapter describes how to use the Map95 program.

Overview
There is a single main screen for mapping operations. The Map95 main screen showing a partially
populated O9500 is shown below. The illustration is annotated with explanatory notes and arrows in red.
The screen can be expanded to a 3rd column for SNCP (Sub-Network Connection Protection) mapping,
explained later in the manual.

Map95 Main Screen Annotated
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Cards in the O9500 are keyed yellow for tributaries, green for the XCU/controller cards and gray for the
low speed AM3440/channel bank type of cards. Map95 mimics these colors within the Map95 program.
The blue section in the middle, the VTE portion, does not relate to a physical card in the O9500. The VTEs
are Virtual T1s or E1s, represented 2 ways; as full T1s or E1 and as DS0s. More about this on the following
page.
A small chassis view is shown at the bottom right. This can be moved around the screen or the chassis view
can be turned off via a selection under the drop-down “View” menu.
The small chassis view is useful as a reminder of the physical position of the cards in the channs.

Screen shot of Map95 showing card color keys and the chassis view
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Map95 has a cross connect section represented in blue. The blue section is located between the green
XCU/controller cards and the low speed cards. The blue section is the virtual (VTE) mapping section. VTE
stands for Virtual T1/E1. There are 2 views of the virtual section. The upper view is at the VT15 or VT2
level, referred to as the DS1 level. VT15 relates to T1, VT2 relates to E1. The lower view is the DS0 view
of the VTE section. The VTE section must be used to cross connect betweem the low speed cards (gray
section) and the XCU (green) and Trib (yellow) cards. The VTE section must also be used if it is necessary
to cross connect, at the DS0 level, circuits that never get down to the low speed card section (gray), that is,
Trib to Trip, XCU to XCU, or Trib to SCU, at the DS0 level.
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VTE type is set using the serial/telnet console. From the main O9500 screen, select G – Map Setup, then
select M – TE Mapper. Here there is a choice for T1, T1-VT12 or E1.
The T1 setting results in 28 DS1 VTEs with 24 DS0 time-slots each for a total of 672 DS0 time-slots.
The T1-VT12 setting results in 21 DS1 VTEs with 24 DS0 time-slots each for a total of 504 DS0 time-slots.
The E1 setting results in 21 DS1 VTEs with 31 time-slots each for a total of 651 DS0 time-slots.

VTE Screen used to Set VTE Type to T1 or E1
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Drop-Down Menus
File Menu
The File menu has options to Select Device, Export Map, Import Map, and Exit the program.

1.

Select Device will open the same window the users sees when the Map95 program is initially
opened. Options are to Connect to Device, connect to a New Device (generating a new license key
file), Edit Device (an existing device license key file), Browse for an existing license key file, or
Exit the program.

2.

Export Map exports the map in comma delimited format (csv) or text (txt) format. The map can
be exported in comma separated value format (csv), text report format (txt), and include assigned
time-slots, unassigned time-slots, or both.
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Choose all time-slots or only mapped time-slots

The user is prompted to select to location to store the file, and to name the file
The map, after the csv file export, formatted in a spreadsheet, looks like the sample below:
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3.

Import Map imports the map from a csv spreadsheet. The imported map must be in the same
format as it was exported. It is recommended that a map be exported and examined to see the
format required for a map to be imported. A sample of the exported map as expressed in a
spreadsheet is illustrated above. Comment rows beginning with “#” can be added. Additional
descriptive columns can be added after column “U”. The added “#” rows and descriptions
following column “U” are ignored on import. The Import Map feature provides a way for a map to
be modified off line, to be restored to an earlier version, to be moved to a different unit, etc.
Selecting Import Map brings up a standard Windows file selection menu as shown below. This
may differ slightly based on view options.

File Selection Menu for Map Import
File import can take a long time. The following screen comes up to remind the user of the potentially long
import time, how to speed up import, and the consequences of an aborted import.
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4.

Print Screen is used to print the current view.
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5.

Transfer is used to print the current view. Click on Transfer for the sub-menu of additional
choices. Transfer uses a TFTP file server, built into the Map95 program. If the Map95 transfer
function is used, any other TFFP file server running on the PC must be closed first. This will avoid
conflicts between 2 running TFTP servers.
“Get” is equivalent to the O9500 upload function. Files are moved from the O9500 to the PC.
“Send” is equivalent to the O9500 download function. Files are moved to the O9500 from the PC.
RTB cards are included in for Get and Send functions because unlike other cards, configurations
are stored on the router cards, not in the controller.

File Transfer Selection

File Transfer Options
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View Menu
The View menu has options to Show Chassis which is the small representation of the chassis, SNCP View
which brings up a 3rd column for SNCP mapping, or Simple View of the TSI map which reduces the
number of interconnect lines for a cleaner view of mapping, especially for very complex maps.

View Drop-Down Menu

Chassis View which can be toggled on an off

SNCP View – See chapter 6 for more details
1.
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Simple View, no interconnect lines across the screen

Simple View toggled off, interconnect lines across the screen
In addition to the Simple View toggle, at the top of each card column is a box to Expand All or Collapse
All. Click on these boxes to either compress the vertical column view as much as possible or expand the
vertical column view to its maximum extent.
Fully expanded, the vertical columns can have hundreds, even thousands of time-slots. Too many to view on
even a floor to ceiling monitor. In a fully expanded view, the sider bars are useful to quickly move upward
or downward through the many time-slots. The Expand All, Collapse All, slider bars, “+” and “-”, Simple
View toggle and SNCP View, can all be used in combination to efficiently navigate through the cross
connects. Below are sample screenshots contrasting the Expand All and Collapse All views.
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Collapse All, SNCP View off

Expand All, SNCP View off
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Collapse All, SNCP View toggled ON
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Expand All, SNCP View toggled ON
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Tools Menu
The Tools menu has options to Retrieve a TSI map, Clear a TSI Map, or Refresh the TSI map.
1.

Retrieve Backup Config issues a command to the O9500 to perform a retrieve operation. This is
the same as "retrieve" in the serial/telnet console. The O9500 re-reads the last stored configuration.
After the retrieve operation completes, the Map95 software will automatically do a refresh.

2.

Rescan device wipes out the TSI map (current map, Map 1, 2 3 or 4 as shown on the top right
hands side of the Map95 screen) and returns that map to a completely un-mapped state.

3.

Clear Map1 and Clear Map2 causes the Map95 software to re-read the map from the O9500. This
comes in handy if the user goes in with the serial/telnet console and directly modifies the map. It is
also useful if there is a communication error between the Map95 software and the O9500 and
Map95 gets out of sync. Some of the Map95 error messages will instruct the user to do a refresh.

Tools Menu

28

Map95 Users Guide
4.

Telnet Console opens a telnet session with the O9500.

Telnet Console
5. Serial Console probes the COM ports and virtual COM ports (for example, if a USB to serial
adapter is being used) to facilitate a direct serial connection to the O9500's console port.

Serial Console
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Map Menu
The Map menu allows selection of Map1, 2 3 or 4. The O9500 has up to 4 maps. Only one of the maps is
working at any time. Most applications use only Map 1. More than 1 map may be used if there is a need to
work on a new map without disturbing a current working map. Maps can also be operational by time of day
or night. For example, one map may be used during the day to carry primarily voice traffic. At night, a
different map may be desired to increase bandwidth for data transfer.

The current map being managed by the Map95 software is shown in the upper right of the main screen.

Help
The Help drop-down menu has an About selection that displays the current software version of Map95.
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O9500 Chassis Image
Map95 by default displays a small view of the O9500 and the installed cards. To the left hand side are the
power supply slots, then the 4 Tributary slots with a yellow color key. In the middle are the 2 XCU slots.
To the right of the XCU slots are 6 low speed slots for channel bank type cards, compatible with single slot
AM3440 slot cards. The right hand 6 slots function like a channel bank, or multiple channel banks. The
right hand 6 slots have the features and mapping functions of the AM3440.
The chassis image can be selected and moved around the PC screen by left-clicking on the image with a
mouse. Holding down the mouse button allows the user to move the image.
The chassis image does not show the VTE mapping space, as the VTE mapping is a memory only function.
There is no physical card representing the VTEs.
The chassis image can be made to disappear using the View menu and un-checking Show Chassis.

Chassis View
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Picking a Card Slot with the Mouse
Below is a partial image of the Map95 screen. Note the cards have boxes to the left with “+” signs in the
box. The “+” indicates that the card has further sub sections that are accessed by clicking on the “+” or the
card name. If the right hand side of the mapping screen was shown, the “+” would shown to the right of the
card name. After clicking on the line, the card expands to sub sections. The second illustration below shows
the E3/T3 card expanded to show that Port 1 of the 3 ports of the card is set to unframed DS3 (STS1) and
that Port 2 is framed, showing a few of the 28 VT15 circuits. Right-clicking on an unmapped high level
section of the card brings up a box with radio buttons, allowing the user to set the granularity of the card, or
subsection of the card.

Click on the “+” to get to the lower granularity sections of a card. As long as there is a “+”, there is a lower
granularity than currently shown. When there is a “-” or no sign, the display is at the lowest granularity
level. Click on the “-” to move up to show less granularity. It may cause cross connect lines to change to
short arrows by the card.

32

Map95 Users Guide

No Function to Turn CAS ON or OFF “On the Fly”
Unlike Map34, Map95 software does not allow CAS to be changed from CAS OFF to CAS ON, and ON to
OFF “on the fly”. This is due to the complexity of cross connects that may tie from the DS0 level to the
SDH/SONET level by way of VTEs (the virtual DS0 to VT12 or VT2 mapping space in the O9500).

Selecting Time-Slots to Map
Select the time-slots to map by highlighting them. Hold down the left mouse key and slide over the desired
time-slots. The time-slots will be highlighted in a darker gray. The same number of slots must be picked on
the top and the bottom cards.
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Selection of Voice or Data for Low Speed Cards
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Automatic Selection of Voice or Data for Low Speed Cards
Low speed cards are non-transport cards.Voice low speed cards are FXS, FXO, E&M. Data low speed
cards include the DTE cards, 8DBRA, 8RS232, Router cards, etc. High speed cards, or trunk circuit cards
that can have DS0s manually set for Voice or Data include T1, E1, FOM, GDSL, TDMoE.
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Select Voice or Data for Pass Through Time-Slots
If one transport card is mapped to another (T1 to T1, E1 to E1, T1 over FOM, E1 over FOM, VTE DS0 to
VTE DS0, etc.), and not directly to a low speed voice time-slot, the DS0 may or may not carry voice traffic.
If the time-slot does carry voice traffic, the card must be mapped as voice. If the time-slot does not carry
voice traffic, the card must be mapped as data. Proper designation of voice or data is required for the voice
signaling bits (AB bits or ABCD bits) to pass through the system correctly. Exception: E&M DS0 timeslots may be set as data if being used without the need to pass the ABCD bits. Setting an E&M as
data, rather than voice will improve the signal to noise ratio (SNR) by about 3 dB. Transmit Only
(TO) E&M circuits will never use the ABCD bits, whether the DS0 is mapped as voice or as data. If
Type I through V type E&M circuits are set to data, the E&M leads will not function. However, they
may chatter on and off, since the ABCD bits are not present. Chattering can be stopped with
appropriate wiring of the E&M leads (or the user can put up with the relay chatter).
The illustration below shows several time-slots selected for mapping. Prior to mapping, the user should
select either voice or data for the DS0s.
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Bidirectional and 1:(N)Multicast
The O9500 can be configured for bidirectional mapping or unidirectional. The Trib and XCU time-slots can
always be either bidirectinal or unidirectional. The VTEs and the 6 low speed slot DS0s default as
bidirectional but can be set to 1:(N)Multicast. The 1:(N)Multicast allows for unidirectional mapping.
To change between bidirectional to 1:(N)Multicast for the low speed cards, from the main O9500 system
screen select “G”, then “C”. This brings the user to the menu shown below.

Default Bidrectional mapping

1:(N)Multicast mapping option

This is a bidirectional mapping. Only the center map option is highlighted

37

Map95 User’s Guide
The above shows the 2 unidirectional options and the bidirectional option for the 1:(N)Multicast setting.

Note that Tributaries and the SCU cards are always capable of unidirectional or bidirectional mapping.
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Activate, Store the Map
The O9500 activates the mapping as soon as it is mapped. There is no activate function.
The O9500 also automatically stores the map after 5 minutes. If the user wishes to force a store, this can be
done through the serial/telnet port. From the main system screen, select the “V” option. If the O9500 is set
up on the bench or in a lab prior to field installation and the unit will be turned off immediately after
mapping, forcing a store is recommended. Below are the screens used to store.

Select the V option to force a Store operation

Select STORE to save the configuration. The save takes up to 2 minutes.
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FOM (Fiber Optic Module Cards) and Time-Slot 16
The O9500 has a 7-port FOM card. Each FOM physical I/O port can carry up to 4 ports of 31 time-slots,
equivalent to 4-E1s per each of the 7 physical optical ports. The FOM card also transports time-slots as
voice or data. To transport voice, the FOM card must to set to FRAME ON and CAS ON.
When set to CAS ON to transport voice, time-slot 16 of the E1 is not available for mapping. It is
automatically selected for signaling. T1 carries the signaling bits (ABCD bits that signal on-hook, off-hook,
ring, etc.) within the DS0 as inband “robbed bit” signaling. When T1 traffic is carried over the 7-FOM card,
the ABCD bits which are in the T1 DS0s, are moved automatically into time-slot 16 of the 7-FOM card
E1s.
Note: If a 7-FOM card is used as a Tributary card in the O9500 and the O9500 has T1s in the low speed
slots, the VTEs must be set to VT2 mode, not VT15 mode. This means that all the Tributary cards and the
XCU cards must also use VT2 mode, rather than VT15 mode. Any O9500 or other SONET device
connected to the O9500 must also match the VT2 mode.

UnMap Time-Slots
Click the time-slots to select what should be unmapped. The selected time-slots will be highlighted. Click
the UnMap button on either side of the screen to UnMap bidirectional mapping. Click on the arrow head
side to UnMap unidirectional mapping on the right hand side of the screen.
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Chapter 5

Operations Requiring the
Serial/Telnet Console
This chapter describes what functions must be done using the serial/telnet console
configuration functions that are not part of Map95.

Overview
Map95 makes time-slot mapping the O9500 faster and more accurate and aids in documentation. The
program is a complement to the serial/telnet console, not a substitute. The following lists some examples of
configuration that must be completed using the O9500 console. Some screenshots are included.

System Configuration
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SNMP Configuration
SNMP System configuration is via the console.

High Speed Tributary Card Configuration
High Speed Tributary cards include the high density E1/T1 card, 3 by DS3 card, High Speed Ethernet card
with FE and gigabit Ethernet, the 7-FOM card, OC3/12 tributary card. Granularity for unmapped Tributary
cards is one exception to what must be configured through the serial/telnet console.

Voice Card Configuration
Low speed voice cards, including FSX, FXO, and E&M are configured with the console.
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Router Card Configuration
The RTB router card is configured using the console.
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Serial Data Card Configuration
Serial data cards require the serial/telnet console for system setup.
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Chapter 6

SNCP Mapping
This chapter describes the SNCP mapping.

Overview
SNCP is Sub-Network Connection Protection. SNCP is a per path connection protection. SNCP mapping
has a primary and secondary path for the protected circuit.
To use SNCP mapping, under the View drop-down menu, select SNCP View. This changes the mapping
view from 2 columns to a three column view. The center column is the local Protected circuit end point.
The right hand column is the Primary link, the left most column is the Secondary path.
Below are 2 screenshots annotated to show the 3 column view and highlight the key functions. The first
screen shows time-slots selected, to be mapped. The second screen shows time-slots mapped. Time-slots
must be selected in all 3 columns. After selecting the proper number of time-slots, the <-PP-A&D-> box
will be highlighted. Click on the highlighted box to complete the mapping.
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Appendix A

Specifications
Map95 Specifications


Map95 works with the Loop Telecommunications International O9500 and selected OEM/ODM
versions.



Map95 runs on Windows XP, XP-Pro, Vista, 7 and 8, both 32 bit and 64 bit, as well as
Windows 2008R2 (which is 64 bit only).




Map95 requires a license for each O9500 controller it supports
Map95 may be used by an unlimited number of technicians on an unlimited number of
workstations.
Map95 is licensed software owned by Data Comm for Business, Inc., 2949 CR 1000E, Dewey,
Illinois, 61840, Tel 217-897-6600.
http://www.dcbnet.com
Link to check for upgrades to newer versions: http://www.dcbnet.com/datasheet/map95ds.html
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